
#AALL16

B-7

You’ve Heard the Jargon, Now Play the Game:
Linked Data on Your Laptop!

Jean M. Pajerek, Coordinator and Speaker
Anna-Sophia Zingarelli-Sweet, Speaker

Jacqueline Magagnosc, Moderator



#AALL16

Jean M. Pajerek
Director for Information 

Management
Cornell Law Library

jmp8@cornell.edu

Presenters

Anna-Sophia Zingarelli-Sweet
Cataloging and Metadata Specialist 
California State University Northridge

annasophia.zingarellisweet@csun.edu



#AALL16

Outline
Part I
• Review of basic linked data concepts
• Walk-through of a pizza ontology 

Part II
• Hands-on practice with Protégé ontology software
• Review of hands-on exercise
• Querying linked data using SPARQL



Information about some of Shakespeare’s plays presented in a familiar format

Presenter
Presentation Notes
If you can interpret a spreadsheet, your brain already understands the concept of triples. This is one form of what is called “structured data,” making it easier for a machine to manipulate.It has its limitations, though. For one thing, this spreadsheet, originally created in Excel (a proprietary software), is just a picture on a PowerPoint slide. The information presented in this spreadsheet can be deconstructed and expressed as triple statements. Each cell in rows 2-12 represents a triple. 



Triple statements

1-5

Subject
(Resource)

Object
(Value)

Predicate
(Property)

This work This author
Was written by

Slide adapted from: Library of Congress BIBFRAME 
Pilot Training for Catalogers, Introduction to the 
Semantic Web and Linked Data, Module 1, Unit 2, 
2015

Presenter
Presentation Notes
At the risk of inducing much eye-rolling …The purpose of a triple is to make statements about resources. The statements can be represented in a graph as shown on this slide.Graph data is the model used for the semantic web. It means that statements about relationships between resources, books, people - almost anything -  can be identified and represented in such a way that computers can process the information about the resources and relationships.The subject, predicate, and object are the basis of the triple statement and are identified in this graph model of the statement: This work was written by this author.(Adapted from LC BIBFRAME training module 1, unit 2)



Some of the triples expressed in the spreadsheet

• Resource 2 has title “As You Like It”
• Resource 2 has author “Shakespeare”
• Resource 2 has genre “Comedy”
In each of these triples, Resource 2 is the subject (or resource). 
The predicate (or property) is expressed by what is in the column 
heading, i.e., (has) Title, (has) Author, or (has) Genre
The object of the triple is a value contained in a cell, e.g., “As You Like 
It,” “Shakespeare,” “Comedy.”

Presenter
Presentation Notes
We can deconstruct the information in the spreadsheet and express it as triples, making it more granular than it is in tabular form.Triple assertions can often be reversed, e.g., “As You Like It” has author Shakespeare, and: Shakespeare is author of “As You Like It.” The positions of the subject and object are reversed, and the properties are “inverses” of each other.



Triple statements

• Subject identifies: “Resource of interest”
• Predicate identifies: Property of the “resource of interest,” a 

relationship
• Object identifies: Property value, a resource that has a 

relationship to the “resource of interest”
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Triple statements 
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Measure for 
Measure Shakespeare

Has author

URI for work, 
“Measure for 

Measure”

URI for author, 
William 

Shakespeare

URI for Dublin Core term: 
creator [read: has creator]

Presenter
Presentation Notes
The top example shows an English language triple statement of the relationship between a work and the author.The bottom example shows what a machine needs to digest the statement and serve a user meaningful information.



Triple statements
The triple statement: 

“Measure for Measure” has creator (or author) Shakespeare

can be expressed in a way that machines can interpret, using VIAF URIs for 
“Measure for Measure,” Shakespeare, and the Dublin Core term for “has 
creator”:

< http://viaf.org/viaf/181321659>
<http://purl.org/dc/terms/creator>
< http://viaf.org/viaf/96994048/>
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Presenter
Presentation Notes
“Measure for Measure” has creator (or author) ShakespeareThis statement is nice for humans to interpret, but not so nice for machines to interpret. And if we want our metadata to be part of the “Web of data,” it needs to be expressed in the language of the Web, which is RDF.



Triples about parts of the United Kingdom
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In this table, we merge 
some data about 
Shakespeare with some 
data about the UK. This 
is easily done when all of 
the data is expressed in 
triples. Notice the points 
of intersection. What 
inferences can we draw 
from this small data set?

Presenter
Presentation Notes
In this table, some information about Shakespeare is merged with some of the geographical information about the UK we saw in the previous slide. Notice the points of intersection. By atomizing data into elemental subject-predicate-object statements, it’s possible to merge disparate sets of data that would otherwise remain siloed. Expressing data from disparate sources in the form of triples makes it interoperable. What inferences can be made, based on the points of intersection of this small set of data?



Inferences we can draw from the merged data:

•Shakespeare married Anne Hathaway
•Shakespeare lived in England
•Shakespeare lived in the UK
•Stratford is part of the UK
•Macbeth is set in the UK

Presenter
Presentation Notes
Consider the inferences we are able to make, even though our data set is very small. Your brain is the “reasoner” that allows you to make these inferences. For example, we know that the assertion that “Anne Hathaway married Shakespeare” implies that “Shakespeare married Anne Hathaway” because we know that people are married to each other. In ontological terms, the property of being married to someone is symmetric (i.e., it works with the subject and predicate going in both directions). With the right support, computers can also make inferences, and on a gigantic scale.



Slide from: Allemang and Hendler, Semantic 
Web for the Working Ontologist, Morgan 
Kaufmann/Elsevier, 2011

Graphic representation of 
triples describing (a) some of  
Shakespeare’s plays and (b) 
some parts of the United 
Kingdom.



Combined graph of 
triples about Shakespeare 
and triples about the 
United Kingdom.

Presenter
Presentation Notes
This diagram illustrates an example of knowledge discovery through the linking of two different data sets.



Linked data graph showing relationships between 
“Shakespeare” and “Stratford”

Graph created using RelFinder:
http://www.visualdataweb.org/relfinder.php

Presenter
Presentation Notes
Here’s what can happen when lots of RDF data are linked together.This is a graph generated by a linked data visualizer called “RelFinder” (http://www.visualdataweb.org/relfinder.php), by entering just two data points: “Shakespeare” and “Stratford.”

http://www.visualdataweb.org/relfinder.php


Wikipedia defines “ontology” as:

“ … a formal naming and definition of the 
types, properties, and interrelationships of 
the entities that really or fundamentally exist 
for a particular domain of discourse”

Presenter
Presentation Notes
The World Wide Web Consortium says about OWL (Web Ontology Language): “The W3C Web Ontology Language (OWL) is a Semantic Web language designed to represent rich and complex knowledge about things, groups of things, and relations between things. OWL is a computational logic-based language such that knowledge expressed in OWL can be exploited by computer programs, e.g., to verify the consistency of that knowledge or to make implicit knowledge explicit. OWL documents, known as ontologies, can be published in the World Wide Web and may refer to or be referred from other OWL ontologies.” 



Class and Subclass

If B=the class of Artworks, and 
A=the class of Sculptures, then 
A is a subclass of B. Everything 
that is a member of subclass A 
is also a member of 
(super)class B. Everything that 
is a sculpture is also an artwork 
(but not every artwork is a 
sculpture).

Presenter
Presentation Notes
Artworks and Sculptures have a straightforward class-subclass relationship. Subclasses of a class usually have additional properties that the superclass does not have. Classes and subclasses can tell us things about relationships between groups of things or categories of things, like “artworks” in general and “sculptures” in general, but it doesn’t say anything about a specific artwork/sculpture, like “The Kiss.”Note: It is possible for an entity to belong to more than one class simultaneously.



Vocabularies and Ontologies

Example of discovering relationships through inferencing:

• Data set says “’The Kiss’ is a sculpture”
• Ontology says “all sculptures are also artworks”
• A semantic web program that understands the concept of 

“all X are also Y” can discover (i.e., infer) a new 
relationship: 

• “’The Kiss’ is an artwork”
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Vocabularies and ontologies:

• are necessary for discovering relationships on the 
semantic web

• define classes and properties
• define relationships between resources
• facilitate “inference” discovery of new information

Slide adapted from: Library of Congress BIBFRAME Pilot 
Training for Catalogers, Introduction to the Semantic Web and 
Linked Data, Module 1, Unit 2, 2015
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Presenter
Presentation Notes
Ontologies allow us to add meaning and relationship information to triple statements. Computers can process the meaningful relationships and serve meaningful search results to humans.



Why use ontology software to understand linked data?

Presenter
Presentation Notes
So far we’ve looked at linked data a couple of ways: triples and graphs. Now we’re going to explore linked data using ontology editing software. Protégé is a “free, open-source ontology editor and framework for building intelligent systems.” Ontology editing software makes it easier to visualize entities, their properties, and the relationships among them.Today we’re working with Protégé ontology editing software, which uses the Web Ontology Language (commonly referred to as OWL). An OWL ontology is also an RDF document. Constructing an ontology imposes a certain degree of rigor on one’s thought processes!When creating an ontology, we’re creating a model of some domain of discourse.



• Now that we have some idea about how linked data is structured, 
how do we search for it and retrieve it? 

• Now that we have some idea about how linked data is structured, 
how do we search for it and retrieve it? 

Now that we have some idea about 
how linked data is structured, how do 
we search for it and retrieve it? 



Selected SPARQL slides ©Steven J. Miller
Used with permission





Presenter
Presentation Notes
People who are familiar with constructing SQL queries, as in Microsoft Access, should recognize the phrase “Select query.”  When I use Access to query our Voyager database, I am most often using a select query. In SPARQL, the query is actually specifying a pattern in the data that should be matched in a result set. Given a particular triple pattern in a query, a SPARQL processor considers sets of triples in the triplestore database that match that pattern.A SPARQL query consists of a set of triples where the subject, predicate and/or object can consist of variables. The idea is to match the triples in the SPARQL query with the existing RDF triples in the database being queried and find values to satisfy the variables. In this select query, the SELECT portion of the query indicates that we want the system to return subject data and object data. The WHERE portion of the query uses the same syntax as an RDF triple (i.e., subject-predicate-object), but the subject and object are variables, as indicated by the question marks. The triple in the query is evaluated against all the RDF triples in the database in which you are running the query. Constant values (i.e., non-variables) in the query triples are matched with constant values of the RDF triples in your database; in this case, the constant value is the property “created.” The PREFIX portion indicates the namespace within which we are performing the query.In our little artworks knowledgebase, the query above will look for and return the subjects and objects that are related to one another by the “created” property.	By the way, you do not have to supply a label for the variables after the question marks; this is just to make both the query and the result set more human-readable.  The computer doesn’t care what you name the variables; it’s just looking for patterns.



Try out this SPARQL query in your own Artworks 
knowledgebase!

Presenter
Presentation Notes
In Protégé, under the Window menu, select Tabs -> SPARQL Query. The SPARQL Query tab will appear adjacent to your other Protégé tabs. Click on it to open it.



Paste this query into the upper pane of the SPARQL screen:

PREFIX sjm: <http://www.sjm.org/artworks#>
SELECT ?subject ?object 

WHERE { ?subject sjm:created ?object} 

This is the ontology’s unique 
identifier; we’re using it to 
declare the namespace within 
which we want our query to run.

We’re looking for all the subjects and objects 
that are connected by the “created” property 
within our declared namespace, which is 
represented by the prefix “sjm.”  

Presenter
Presentation Notes
Once you have the SPARQL screen open, type the text of the query into the upper pane (beginning with “PREFIX” and ending with the right curly bracket).The query follows the same exact pattern as an RDF triple: subject-predicate-object, except that the subject and object are represented by variables, as indicated by the question marks. We know that “created” is an object property in the knowledgebase. The query will look at all instances of triples where “created” is the predicate and return the subjects and objects from those triples. 



Your SPARQL screen 
should look like this.

When you’re ready, click on the 
“Execute” button to run the query.



Did you get the results you expected?



Exploring SPARQL queries

A fun and instructive place to go to explore sample SPARQL 
queries is:
Wikidata Query Service – click on the “Examples” button, then 
click on the “Run” button below the query box
https://query.wikidata.org/

There’s a very helpful intro to the Wikidata Query Service at:
https://www.wikidata.org/wiki/Wikidata:SPARQL_query_service/A
_gentle_introduction_to_the_Wikidata_Query_Service

Presenter
Presentation Notes
The Wikidata sample queries are especially useful because some attempt is made to explain the structure of the query, and if you hover your mouse over the data constants a box pops up, explaining what that element is.There’s also a beginner-friendly course for SPARQL at: https://www.wikidata.org/wiki/Wikidata:A_beginner-friendly_course_for_SPARQL.

https://query.wikidata.org/
https://www.wikidata.org/wiki/Wikidata:SPARQL_query_service/A_gentle_introduction_to_the_Wikidata_Query_Service


Sparklis – a graphical interface for SPARQL queries

http://www.irisa.fr/LIS/ferre/sparklis/

Presenter
Presentation Notes
Sparklis offers a graphical user interface for creating SPARQL queries. There’s a YouTube tutorial you can watch (although it seems out of date) and many sample queries to study. The “YASGUI” view shows you what a query looks like in raw SPARQL syntax.

http://www.irisa.fr/LIS/ferre/sparklis/


Other sites for exploring SPARQL queries:
European Union Open Data Portal
https://data.europa.eu/euodp/en/linked-data

The British National Bibliography as Linked Open Data
http://bnb.data.bl.uk/flint-sparql

Getty Vocabularies LOD (Linked Open Data) Sample Queries
http://vocab.getty.edu/queries

FactForge – Scroll down to the “Saved SPARQL queries”
http://factforge.net/

Presenter
Presentation Notes
The vocabularies developed by the Getty Information Institute include: Art and Architecture Thesaurus (AAT), the Thesaurus of Geographic Names (TGN) and the Union List of Artist Names (ULAN; people and corporate bodies).

https://data.europa.eu/euodp/en/linked-data
http://bnb.data.bl.uk/flint-sparql
http://vocab.getty.edu/queries
http://factforge.net/


Tell me again … 
WHAT does this 

have to do with my 
job?



BIBFRAME is an ontology! 

Presenter
Presentation Notes
Understanding how ontologies work will give us insight into how BIBFRAME is structured.



Check out the BIBFRAME Comparison Tool at:
http://id.loc.gov/tools/bibframe/compare-id/full-ttl

Presenter
Presentation Notes
The BIBFRAME Comparison Tool lets you enter a Bib ID from LC’s catalog or an LCCN, and display the MARC record side-by-side with the BIBFRAME 2.0 version of that record. A couple of things you might notice right away: the BIBFRAME version of the record does not seem to present the metadata in an order that in any way resembles the order of the MARC record. Also, the BIBFRAME records is much longer than the MARC record. That’s because the BIBFRAME record breaks the metadata down into very granular, atomized bits of data.

http://id.loc.gov/tools/bibframe/compare-id/full-ttl


Casalini’s SHARE-VDE project
http://www.share-vde.org/sharevde/clusters?l=en

Presenter
Presentation Notes
Casalini’s SHARE-VDE project (Scholarly Heritage and Access to Research-Virtual Discovery Environment)The SHARE catalog offers two modes of query entry on the home page.
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Thank you for your attention!
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Note: This is a hands-on exercise using the freely available ontology software Protégé. Protégé can be 
downloaded here: http://protege.stanford.edu/. You will also need a file called Exercise_artworks.owl, 
downloadable from this URL: http://tinyurl.com/ybodlyst. 

Launch Protégé and use it to open the Artworks ontology file (Exercise_artworks.owl). To open the 
ontology file, click Control-O or, under the File menu, select “Open.” Navigate to where the 
“Exercise_artworks.owl” file is on your computer. Your screen should look something like this: 

 

 

Under the “View” menu, make sure the “Render by label” view is selected. Notice the tabs near the top 
of the display. Click on the tab that says “Entities.” When you click the “Entities” tab, it brings up a 
display that looks like this, with perhaps some of the same tabs displayed again: 

 

 

 
This exercise is adapted from course materials created by Prof. Steve J. Miller.  
Used with permission. 
 

http://protege.stanford.edu/
http://tinyurl.com/ybodlyst
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The “Object properties” tab 

For the purposes of this exercise, we’ll focus on Classes, Object Properties, Data Properties, and 
Individuals. The screenshot above shows Object properties (within the Entities tab). Object properties 
assert a specific relationship between two different entities in a triple statement, for example, 
“Michelangelo created David.” In this triple statement, “created” is the object property (also the 
“predicate” of the triple), asserting a relationship between the individuals “Michelangelo” and “David.” 
Notice that just like in the pizza ontology, these object properties begin with lower-case letters, and are 
written out in what’s called “camel case.” According to Wikipedia, camel case “is the practice of writing 
compound words or phrases such that each word or abbreviation in the middle of the phrase begins 
with a capital letter, with no intervening spaces or punctuation.” Note also that in Protégé, object 
properties are symbolized by blue rectangles. So far, our ontology has just a few object properties. They 
are all subproperties of the topObjectProperty. Note that it’s possible for a property like “created” to 
have subproperties of its own; for example, a subproperty of “created” in this namespace might be 
“painted” or “sculpted.” 

Next, let’s look at the “Individuals” tab. The ontology has been pre-populated for you with a few 
individual entities (also known as “instances”). In Protégé, individuals, or instances, are symbolized by 
purple diamond shapes. The caption bars in the various panes of the display are color-coded to 
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correspond to the parts of the ontology they refer to. The caption bars here are purple, to correspond to 
the purple diamonds symbolizing individuals. 

 

The “Individuals” tab 

Something interesting to notice about this screen is that there are two individuals labelled “Italian.” By 
clicking on each instance labeled “Italian,” you will see that one instance refers to Italian as a language, 
while the other instance refers to Italian as a nationality. Alternatively, under the View menu at the top 
of the screen, select “Render by prefixed name.” Notice the changes in the appearance of the list of 
individuals. In looking at the prefixed names (indicated by the preceding colons), we can see from the 
comment in the Annotations pane that these two entitles actually have different names, but their rdfs 
(RDF Schema) labels are the same (see below): 

 

Since we’re in the Individuals tab, let’s make an object property assertion (i.e., a triple statement) about 
Michelangelo. To do this, select Michelangelo in the list of Individual entities (you might have to double 
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click). Notice that information about Michelangelo now appears in some of the other panes of the 
display, noting in particular the “Property assertions” pane on the bottom right. We can see that there 
are some “object property” assertions that have been made about Michelangelo, as well as some “data 
property” assertions (i.e., his birth and death dates). We’re going to add an object property assertion 
that Michelangelo worked in Florence. Remember that an object property asserts a specific relationship 
between two different entities in a triple statement; in this case, the relationship being asserted 
(“workedIn”) is between Michelangelo and Florence. 

Under the “View” menu at the top of screen, select “Render by label” to return the display to the non-
prefixed view.  If you don’t do this, you’ll have to remember to add the colon to your triples – it works, 
but how annoying! To add the object property assertion that “Michelangelo worked in Florence” to our 
ontology, click on the plus sign in the Property assertions pane, right next to where it says “Object 
property assertions” (where the red circle is in the illustration below).  

 

 

 

 

Once you’ve clicked the plus sign, a small screen will pop up, with two blanks for you to fill in like this: 
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We are asserting an object property with Michelangelo as the subject, workedIn as the predicate, and 
Florence as the object. Data entry tip: once you’ve typed in a few letters, try using Control-space to 
auto-complete the field. Once you click OK, your object property assertion will appear in the Property 
assertions pane, along with the other property assertions about Michelangelo!  

  

Now we’re going to add a new individual to the list of individuals, FridaKahlo, and make some property 
assertions about her. 

Under the View menu, switch the view to “Render by prefixed name.” In the pane displaying the list of 
individuals, click near the upper left-hand corner, where you see the purple diamond with a plus sign 
next to it: 

    

In the box that appears, type FridaKahlo, and click OK. Notice that :FridaKahlo appears in the list of 
individuals. In this case, Protégé supplies the preceding colon for you. 

Now we’re going to add a lexical label for our new entity. Make sure FridaKahlo is selected in the list of 
individuals. In the “Annotations” pane, click on the plus sign. On the screen that appears, select 
rdfs:label in the left-hand pane. Type Kahlo, Frida in the right-hand pane, making sure that you are in the 
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“Literal” tab of that pane. At the bottom right-hand side of the screen, select xsd:string from the drop-
down menu next to the word “Type.” Click OK when you’re done. 

 

Under the View menu, switch the View to “Render by label” and notice what Frida Kahlo’s name looks 
like. Switch the view back to “Render by prefixed name.” 

Add a new individual with the name “Work9876.” Give the entity (a work this time) the annotation label: 
The Love Embrace of the Universe. Select the individual Frida Kahlo and make an object property 
assertion that she created Work9876 (The Love Embrace of the Universe). Be sure to add the colon 
before the object property “created" and in front of “Work9876.” Your new object property assertion 
should look like this: 
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While remaining within the Individuals tab, make a data property assertion (within the Property 
assertions pane, below the Object property assertions) that Kahlo’s birthdate was 1907-07-06. In 
Protégé, data properties are represented by green rectangles. Data properties relate an entity to literal 
data, like numbers or a textual string; in this case, we’re asserting an individual’s date of birth. When 
making this assertion, in the dropdown menu for “Type,” click on “string,” then on the “OK” button. This 
asserts that the datatype of this value is a string of characters. (Note: her death date was 1954-07-13 if 
you want to add that.) You can always go back and edit an assertion by clicking on the gray circle next to 
it. Your new data property assertion(s) should look like this: 
 

 
 
Now we’re going to create some classes in our ontology. Classes are sets of types of things and  
subclasses are subsets of their parent class. Every class should have at least a few individual entities as 
members of that class or set; otherwise, there is no point in the existence of that class. Individuals may 
be asserted to be instances of one or more classes. All classes in OWL are subclasses of owl:Thing. 
Every member is a “thing” or “entity” in the RDF / linked data /Semantic Web sense of that term. 
 
Click on the “Classes” tab in Protégé. In Protégé, classes are symbolised by gold circles. Notice that 
owl:Thing is already at the top of the class hierarchy. All the classes we’ll create will be subclasses of 
owl:Thing. This is true of every OWL ontology. 
 
To add classes to the class hierarchy, select “owl:Thing” and notice that the button in the upper-left 
corner of the pane becomes enabled. This is the “Add subclass” button; click on it. 
 

  
 
 
In the window that appears, type Artist, and click OK. “Artist” now appears in the class hierarchy as a 
subclass of owl:Thing. Add Artwork and Institution as subclasses of owl:Thing in the same way. Notice 
that we are adhering to the ontological convention of naming classes with words that begin with capital 
letters. 
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Now we are going to assert that some individuals are instances of the classes we created. To do this, 
click on the “Individuals” tab and select Michelangelo. In the bottom middle pane labeled “Description,” 
click on the plus sign next to the word “Types”: 
 

  
 
In the window that appears, select the tab that says “Class hierarchy” and then click on “Artist” within 
the hierarchy that appears; then click OK. 
 

 
 
Returning to the “Classes” tab, when you click on “Artist” within the class hierarchy, you’ll see in the 
“Description” pane that Michelangelo has been added as an “Instance” of the class “Artist.” Following 
the same steps, assert that Frida Kahlo is an instance of the “Artist” class, and that “David” and “The 
Love Embrace of the Universe” are instances of the class “Artwork.” The same result can be achieved 
from within the Classes tab, by selecting one of the classes and clicking on the plus sign next to 
Instances in the Description pane on the bottom right side of the screen, then selecting the appropriate 
individual entity from the list that appears. 
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In the Classes tab, create the following class hierarchy (hint: “Person” is a subclass of owl:Thing; you’ll 
have to click on owl:Thing to position your cursor correctly): 
 Person 
      Artist 
           Painter 
           Sculptor 
           Architect 
 
Start by creating a new top-level class called “Person” directly under “Thing.” Then click and drag the 
already existing Artist class on top of Person, and it will become a subclass. An alternative is to click on 
SubClassOf in the Description pane for Artist and select Person.  
 
Add more new top-level classes named Style/Period, Language, and GeographicLocation. 
 
Add three sibling subclasses under GeographicLocation named Continent, Country, and 
City. Your class hierarchy should look like this: 
 

  
 
Go the the Individuals tab and assert that GabrieleMunter is a member (or instance) of the Painter class. 
 
In the Object properties tab, add a new object property named “hasStyle/Period.” 
 
In the Individuals tab, add a new individual, “NaiveArt.” In the Annotations pane of the Individuals tab, 
create an rdfs:label for this individual, Naive art. 
 
Assert that NaiveArt is a Style/Period. 
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In the Individuals tab, make an object property assertion about the individual artwork “Love Embrace of 
the Universe” that it hasStyle/Period “NaiveArt.” 
 
Add MexicoCity, Coyoacan, Italy, Mexico, Europe and NorthAndCentralAmerica to the list of Individuals. 
 
Assert that Florence, MexicoCity, and Rome are each a City (members of the City class), 
that Italy and Mexico are each a Country, and that Europe and NorthAndCentralAmerica 
are each a Continent.  
 
Assert that GalleriaDellAccademia is an Institution. 
 
Assert that Frida Kahlo was born in Coyoacan and that she worked in Mexico City. Hint: “wasBornIn” 
and” workedIn” are object properties. Your property assertions for Frida Kahlo should look like this: 
 

  
 
In the Object properties tab, add a new object property called isLocatedIn. Then assert that Mexico City 
isLocatedIn Mexico, that Mexico isLocatedIn NorthAndCentralAmerica, that Rome isLocatedIn Italy, 
and Italy isLocatedIn Europe. 
 
Question: why did we use the object property “isLocatedIn” to show the relationship between 
cities, countries, and continents instead of making a class hierarchy for them? Why is it valid to 
have all three of these as sibling subclasses of GeographicLocation, but not to have City as a 
child subclass of Country and Country a subclass of Continent? 
 
Add a new class named Gender. We want to make the statements that FridaKahlo 
hasGender Female and Michelangelo hasGender Male, so we’ll also need to create a new object 
property, hasGender. In a traditional controlled vocabulary consisting of broader and narrower terms in 
a hierarchy, Male and Female could be narrower terms under Gender. Male and Female are also types 
of gender. In our ontology, should Male and Female be Classes or Individuals? Why? Try adding one as a 
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subclass of Gender and then try making a statement about one of the artists using the hasGender 
property. Why is this impossible to do? Instead, add Male and Female as individuals and then make the 
statements about Kahlo’s and Michelangelo’s genders. 
 
Save your ontology (Ctrl-S or “Save” under the File menu.). 
 
We’ve made some assertions that enable some inferences about class membership to be made. To see 
the inferences, click on the Reasoner menu at the top of the Protégé window and click on “Start 
Reasoner.”  If you are shown a choice of reasoners, choose HermiT. 
 

 
 
Be sure that the “Show Inferences” box in the bottom right corner of the Protégé window has been 
checked. Based on what we have, you won’t see any inferences immediately. 
 
Select the Classes tab, then go to the Window menu option at the top of the Protégé screen and select 
Window > Views > Ontology views > Classification results. Drag and then release the black circle 
somewhere in the Classes frame area – try dragging it into the lower part of the Annotations 
frame until you see a black line appear (showing that a new frame will be added) then 
release. You should now see a new frame that looks like this: 
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Click on the question mark symbol to the right of any of these inferences to see an explanation of how 
the reasoner arrived at this inference. Inferences do not become part of the ontology unless you 
explicitly “assert” them. 
 
For the next part of the exercise, stop the reasoner by selecting “Stop reasoner” under the Reasoner 
menu at the top of the screen. 
 
Domain and Range 
This part of the exercise will introduce the concepts of “Domain” and “Range.” 

• “Domain” indicates that the subject of a property must be a member of a specific class. 
• “Range” indicates that the object of a property must be a member of a specific class. 

 
For example, let’s say we want to connect the property “created” with the types of entities (classes) that 
can be used with it: 

The subject of the “created” property must always be a member of the class “Artist” 
The object (value) of the “created” property must always be a member of the class “Artwork” 
 
Put another way, the domain of the “created” property is “Artist,” and the range of the “created” 
property is “Artwork.” Therefore if we assert that Michelangelo created David, the ontology can infer 
that Michelangelo must be an Artist and that David must be an Artwork. The concepts of domain and 
range can apply to both object properties and data properties. 
 
Domain and range assertions are added by clicking on the plus signs next to the words “Domains” and 
“Ranges” in the “Description” pane in the bottom right corner of the Object properties screen. Click on 
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the Object properties tab and add domain and range specifications for some of the object properties 
we’ve asserted: 
 
Object property - created  
domain - Artist  
range - Artwork  
 
Object property - isHousedIn 
domain - Artwork  
range - Institution  
 
Object property - isLocatedIn  
domain - GeographicLocation  
range - GeographicLocation 
 
In the screenshot below, we’ve asserted that for the object property “created,” the domain is “Artist” 
and the range is “Artwork.” Trying to translate this into English, we could say that “Some member of the 
Artist class created some member of the Artwork class.” We have asserted that Frida Kahlo and 
Michelangelo are members of the Artist class. (Gabriele Münter was asserted to be a member of the 
class “Painter,” but her membership in the class “Artist” has only been inferred by the reasoner, not 
explicitly asserted by us.) We have asserted that “David” and “The Love Embrace of the Universe” are 
members of the Artwork class. Having asserted a domain and range for the property “created” within 
our small knowledgebase, triple statements that use the object property “created” must have a subject 
who is either Frida Kahlo or Michelangelo, and an object that is either “David” or “The Love Embrace of 
the Universe.” 
 
Notice that for the object property “isLocatedIn,” the domain and range are the same, i.e., the class 
“GeographicLocation.” In English, we’re saying something like: “Some member of the 
GeographicLocation class is located in some other member of the GeographicLocation class.” For 
example, “MexicoCity (a member of the “City” subclass of the “GeographicLocation” class)  isLocatedin 
Mexico (a member of the “Country” subclass of the “Geographic Location” class). Assertions that are 
true of a class are also true of its subclasses. 
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To see the impact that asserting domain and range can have on inferencing, click on the Individuals tab 
and select Michelangelo. In the Description pane (the bottom center pane of the Individuals display) 
where we asserted that Michelangelo is a member of the “Artist” class, click on the X button to remove 
this assertion. Then, under the Reasoner menu at the top of the screen, select “Start reasoner.” Make 
sure the “Show inferences” box in the bottom right corner of the screen is checked. Note that an 
inference appears (highlighted in pale yellow) which says, essentially: “Michelangelo belongs to the 
“Artist” class.” Clicking on the question mark next to the inference, we see this rationale for the 
inference: 
 

 
 
Because we asserted that the domain for the object property “created” has to be an artist, and we 
previously asserted that “Michelangelo created David,” the reasoner was able to infer correctly that 
Michelangelo must be an artist. 
 
Data properties can also have domain and range specifications. Click on the Data properties tab and 
select the data property “hasBirthDate.” In the “Description” pane, in the bottom right corner of the 
screen, assert that the domain for this data property is the class “Person” and the range is xsd:string; 
xsd:string is a “Built in datatype” in Protégé, so you’ll need to access the “Built in datatypes” list after 
clicking on the plus sign next to the word “Ranges” to select xsd:string (see the following screenshot). 
After you’ve selected it, click OK. 
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We’ve asserted that an instance of the “Person” class has to be the subject of the property (or 
predicate) “hasBirthDate.” The object of such an assertion has to be a string of “literal” values, in this 
case, the numerals that indicate the birthdate of whoever the subject of the triple is, e.g., “Frida Kahlo 
(an instance of the “Person” class) hasBirthDate 1907-07-06 (a string of literal values). 
 
If you want to save your ontology to look at later, select “Save” under the Edit menu, or type Control-S. 
 
The screenshot below shows a portion of what our ontology looks like when serialized (formatted) using 
Turtle (Terse RDF Triple Language) syntax. Turtle is considered a relatively human-friendly RDF syntax, 
but it is still not as easy for humans to interpret as the Protégé version.  
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The bracketed lines at the top are called the “namespace declaration.” When a namespace is defined 
for an element, all child elements with the same prefix are associated with the same namespace. 
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Viewing ontologies in Protégé 

It can be instructive (or completely baffling; you decide!) to look at existing ontologies using Protégé. For 
example, to look at the Getty Vocabularies ontology in Protégé, click on File menu and select “Open 
from URL.” If a dialogue box appears, asking whether you want to open the ontology in the current 
window, click on “No.”  Type the following in the box labeled “URI”: 

http://vocab.getty.edu/ontology 

Then click “OK.” You should see something like this: 

 

Here are a couple law-related ontologies you can open the same way: 

http://publications.europa.eu/mdr/resource/eli/eli.owl (European Legislation Identifier Metadata 
Ontology  - this one is fun because, in addition to being law-related, it uses some concepts and 
terminology taken from FRBR and RDA! 

http://justinian.leibnizcenter.org/MetaLex/metalex-cen.owl (Open XML Interchange Format for Legal 
and Legislative Resources) 

 

 

http://vocab.getty.edu/ontology
http://publications.europa.eu/mdr/resource/eli/eli.owl
http://justinian.leibnizcenter.org/MetaLex/metalex-cen.owl
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You can also open the BIBFRAME 2.0 vocabulary from within Protégé; in this context, “vocabulary” 
refers to definitions of both classes and properties: 

http://id.loc.gov/ontologies/bibframe.rdf 

 

 

  

http://id.loc.gov/ontologies/bibframe.rdf
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GLOSSARY 

 

Classes: Also known as sets. Members of classes share some properties or characteristics. 

Entities: Entities are the fundamental building blocks of OWL ontologies, and they define the vocabulary 
— the named terms — of an ontology. Classes, datatypes, object properties, data properties, annotation 
properties, and named individuals are entities, and they are all uniquely identified by an identifier. 

Individuals: Individuals (instances) are the basic, "ground level" components of an ontology. The 
individuals in an ontology may include concrete objects such as people, animals, tables, automobiles, 
molecules, and planets, as well as abstract individuals such as numbers and words (although there are 
differences of opinion as to whether numbers and words are classes or individuals). An ontology need 
not include any individuals, but one of the general purposes of an ontology is to provide a means of 
classifying individuals, even if those individuals are not explicitly part of the ontology. Individuals may 
be members of one or more classes. The term instances is sometimes used interchangeably with 
individuals. 

Namespace: Namespaces identify vocabularies and syntaxes used to make semantic statements about 
resources. Namespaces are used to declare formats, syntaxes, and sources of terms. In RDF, the 
assumption is that a class or property from any namespace can be used at any point. It is quite normal 
for the subject, predicate, and object of a triple to be URIs from different namespaces. RDF promotes 
the mixing and matching of vocabularies, and the goal of Linked Data is to connect as many data points 
from as many different sources as possible. Namespace prefixes are often used to stand in for a URI to 
streamline the syntax of RDF metadata. 

Ontology: A formal representation of a set of concepts within a domain (i.e., an area of knowledge) and 
the relationships between those concepts. 

Properties: Properties describe the relationships between entities, or between entities and data values.  

RDF - The Resource Description Framework: This is the basic framework that the rest of the Semantic 
Web is based on. RDF provides a mechanism for allowing anyone to make a basic statement about 
anything and layering these statements into a single model. RDF has been a recommendation from the 
W3C since 1999. 

RDFS (RDF Schema): RDF Schema provides a data-modelling vocabulary for RDF data. RDF Schema is a 
semantic extension of RDF. It provides mechanisms for describing groups of related resources and the 
relationships between these resources. RDF Schema is written in RDF. These resources are used to 
determine characteristics of other resources, such as the domains and ranges of properties (LC 
BIBFRAME training, module 2, slide 44). RDFS has been a W3C recommendation since 2004. 

RDF triple: The fundamental data structure of RDF. A triple is made up of a subject, predicate, and 
object. Vocabularies and ontologies define relationships within a triple statement.  
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Triplestore: A database for storage and retrieval of RDF triple statements; searched using RDF query 
language called “SPARQL.” 

Simple Knowledge Organization System (SKOS): SKOS is a W3C recommendation designed for 
representation of thesauri, classification schemes, taxonomies, subject-heading systems, or any other 
type of structured controlled vocabulary. SKOS is part of the Semantic Web family of standards built 
upon RDF and RDFS, and its main objective is to enable easy publication and use of such vocabularies as 
linked data. 

SPARQL: RDF query language; searches triplestore data sets  

SPARQL endpoint: a service that accepts SPARQL queries and returns results 

Serialization: RDF serialization formats are the programing languages that are used to encode RDF triple 
statements. Serialization is the process of translating data structures into a format that can be stored or 
transmitted across a network connection link and reconstructed later in the same or another computer 
environment. 

Web Ontology Language (OWL): The Web Ontology Language (OWL) is a family of knowledge 
representation languages of varying complexity for authoring ontologies. OWL has more facilities for 
expressing meaning and semantics than XML, RDF, and RDF-S, and thus OWL goes beyond these 
languages in its ability to represent machine-interpretable content on the Web. OWL is used to formally 
document RDF classes and properties. 

 

Sources 

Allemang, Dean, and Jim Hendler. Semantic Web for the Working Ontologist: Effective Modeling 
in RDFS and OWL. Morgan Kaufmann, 2011. 

Pollock, Jeffrey T. Semantic Web for Dummies. Wiley, 2009. 

Riley, Jenn. Understanding Metadata: What is Metadata, and What is it for? National 
Information Standards Organization, 2017. 

Stuart, David. Practical Ontologies for Information Professionals. Neal-Schuman, 2016. 

W3C website (https://www.w3.org/). 

Wikipedia (https://www.wikipedia.org/). 
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ObjecIves	

•  Introduce	the	Protégé	interface	
•  Demonstrate	primary	funcIonaliIes	
•  Illustrate	key	terms	
•  Make	it	look	easy!	



Protégé	

•  I’m	using	Protégé	5.1.0	
•  A	data	uIlity	
•  Provides	an	interface	for	structuring	data	and	
saving	it	in	a	variety	of	formats.	



Source	

A	PracIcal	Guide	to	Building	OWL	Ontologies	
Using	Protégé	4	and	CO-ODE	Tools	EdiIon	1.3	
	
Ma?hew	Horridge,	University	of	Manchester,	©2011	
	
Based	on	an	idea	by	Chris	Wroe	and	Robert	Stevens	



Quick	note	on	rights:	

•  Tutorial	by	Ma?hew	Horridge	is	copyright	of	
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•  Pizza	ontology	is	CC-BY-3.0.	Contributors	are	
Alan	Rector,	Chris	Wroe,	Ma?hew	Horridge,	
Nick	Drummond,	and	Robert	Stevens.	

•  These	slides,	by	me,	are	are	CC-0.	



Key	Terms:	Not	Just	Jargon	

•  Classes	and	Subclasses	
•  Disjoint	Classes	
•  Object	ProperIes	
•  Data	ProperIes	
•  Inverse	ProperIes		
•  Domain	
•  Range	



Opening	from	URL	









Adding	a	comment	



CreaIng	a	Class	



Specifying	Disjoint	Classes	
so	an	individual	or	object	cannot	be	a	member	of	both	classes	



Protégé	doesn’t	know	that	something	can’t	be	both	a	
PizzaTopping	and	a	PizzaBase	unless	you	tell	it!	



CreaIng	Subclasses	



Making	sibling	classes	disjoint	



OWL	ProperIes	

•  Object	properIes	
– Define	relaIonships	between	two	individuals	
– e.g.	“Anna-Sophia”	hasPet	“Amory”	
	

•  Data	properIes	
– Assigns	data	values	to	individuals	
– e.g.	“Anna-Sophia”	hasAge	“29”^xsd:integer	
	

•  AnnotaIon	properIes	



CreaIng	Object	ProperIes	



CreaIng	Inverse	ProperIes	





Types	of	Object	ProperIes	

•  FuncIonal	
•  TransiIve	
•  Symmetric	
•  Asymmetric	
•  Reflexive	
•  Irreflexive	



Domains	and	Ranges	

•  Object	properIes	link	individuals,	from	a	
domain,	to	other	individuals,	from	a	range.	



Adding	a	Range	



Adding	a	Domain	



DescripIon	of	hasTopping	



“Pizza”	hasTopping	“PizzaTopping”	
	
	

Domain							Object	Property																					Range	



Class	DescripIon	



ExistenIal	DescripIons	
“What	is	a	HawaiianPizza”?	



Other	Tools	

•  Reasoners	
•  Inferences	



Save	Formats	



QuesIons?	
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